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Workshop description 

In this course, participants will learn how to set up an organizational system 

on Schoology for instructional materials (documents, links, multimedia) and 

then to upload these materials.  Topics covered will include:  creating and 

editing course/unit folders, preparing course materials as PDFs, uploading 

and editing course materials, and using the “Collections” and “Resources” 

functions on Schoology.  The instructor will also discuss how to use Notability 

in conjunction with Schoology to reinforce good organizational skills in 

students.  A basic knowledge of Schoology is helpful for participants. 
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How will you organize your materials on Schoology ? 

Schoology will allow you to add files, assignments, tests/quizzes, links and 

more, but first, it is important to consider how you will organize your 

instructional materials (as this provides a model of organization for your 

students). 

1. Will you organize your course by units? 

2. Will you organize your course by modules? 

3. Within each unit/module, what subfolders will you want to use? 

a. Classwork? 

b. Homework? 

c. Assignments? 

d. Other? 

 

Essential question:  What do you want your 

students’ electronic files to look like? 

 

  



Understanding the Schoology – Notability flow process 

 

  

Teachers use Schoology: 

 To store instructional files; 

 As a delivery mechanism for 

instructional and multimedia 

materials; 

 As means to model organization 

for students; 

 To receive, annotate, evaluate and 

return student assignments; 

 As a gradebook; 

 As means of communication with 

students and parents 

 

Students use Schoology: 

 To download course materials; 

 To submit assignments; 

 To monitor their grades; 

 To communicate with the teacher. 

 

Students use Notability: 

 To annotate notes and 

assignments 

 To store instructional materials 

 

Teacher uploads 
instructional files to 

Schoology in organized 
folders. 

Students open files from 
Schoology and import them 

to Notability. 

Files to be kept as notes are 
stored in Notability in 

organized folders, guided by 
the naming conventions 

established by the teacher. 

Assignments are completed 
(annotated) in Notability and 
then uploaded to Schoology. 

Teacher evaluates the 
assignment and gives 

feedback (or a grade) using 
Schoology. 

If necessary, student makes 
revisions on Notability and 

resubmits the assignment to 
Schoology. 



Setting students up for good organization in Notability 

Instructional materials that are delivered electronically should to be 

organized into an easily searchable filing system from which students can and 

will retrieve these materials. 

Teachers can facilitate improved organizational skills among students by: 

1. Modeling organization in the way they set up Schoology files; 

2. Naming files systematically so that they are automatically organized 

when imported into Notability. 

Here is a sample naming convention that will accomplish the aforementioned 

goals: 

U3 - 05 - Notes – Chapter 1 

The unit in which the 
document is located 

The day of the unit on 
which the file will be 

used. 

Name that identifies the 
content of the file 

This will put all of the 
unit’s files together and 

immediately indicates to 
the students to store the 
file into the correct unit 

folder. 

This will put all files to be 
used each day together 
so that the teacher can 

tell students to “Open day 
5 files.”  It is important to 
use two digits not one so 
that numbers above nine 
are listed in the correct 
order (not after one). 
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 Resources 

1. Your Schoology account contains a 
“Resources” section where files can be kept 
before they are added to a class (as is the 
case when teachers update their documents 
over the summer). 

2. Think of your “Resouces” as a physical filing 
cabinet where you keep all of your master 
files that you want to remain untouched by 
others.  

3. Click on the “Resources” tab along the main 
menu (blue). 

4. There are four different types of resources: 

a. Personal – this is where you will keep all of your teacher files. 

i. Only you have access to your personal resources. 

ii. You will organize your entire course under a single 
collection within “Personal resources” and then move those 
course materials at your own pace to the classes you teach. 

b. Public – if you wish to make some of your files available to 
anyone with an internet connect, you can put them in your “Public 
resources”. 
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c. Group – if you create a group, you can share resources with them 
by putting files in “Group resources”. 

i. A group is an assembly of people with whom you wish to 
share resources, but who are NOT a class.  An example 
might be a PLC or an after school club or a team. 

d. Apps – This is an advanced feature allows you to connect “Cloud 
Storage Services” such as Google Drive, Dropbox, or Microsoft 
OneDrive to your resources, so that you have access to these files 
from within your “Resources”.  (This skill will be covered in an 
“intermediate” Schoology workshop to be offered later in the 
year.) 
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Setting up your personal resources – the process 

1) Within “Resources” you will create a “Collection” for each distinct course 
you teach.  (Note: if you teach multiple sections of the same course, you will 
use a single collection for them.)  Within the collection, you will keep your 
“master files” for each course. 

2) Only you have access to your collections (students do not), although it is 
possible to share collections with colleagues or make them public. 

3) You will then create your organization system (folders & subfolders) 
within each collection. 

4) You will then populate those folders and subfolders with files. 

5) When your unit/modules folders are ready, you will “add” them to the 
course in September (or throughout the year).  Students will then have 
access to these files. 

a) Your “master files” within your collections in “Resources” remains 
untouched. 

b) Students have access to a copy of these files as you add them to a course.  
They cannot make changes to the original files within your collections. 

6) You are able to add files directly to a course during the year (that is, not 
adding them to “Resources” and “adding” them to a course, but rather 
uploading the file directly within a course).   

a) This action does NOT add that file to your collections in “Resources”. 

b) At the end of the year, teachers will perform a “Master Backup” for each 
course into their “Resources” so that any files created during the year 
and added directly to courses will be add to their permanent collections 
within resources. 
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Collections 

1. Collections are housed within Resources.  Remember to think of a 
Collection as a large filing cabinet where you keep all of your master 
files. 

2. Teachers will create one collection for each distinct class they teach (but 
if they teach more than one section of the same class, they create only 
one collection). 

3. Click on “Resources” from the blue 
main menu, then “Personal”. 

4. Your collections will be listed under 
“My Resources”.  By default,  you will 
have the following collections: 

a. Home 

b. Learning Objectives – this allows 
you to align various assignments 
to state and national standards.  
This topic will be covered in 
another Schoology workshop in 
the Fall. 

c. Downloads 

d. Public 

e. Your collections (whatever else 
you add) 
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Creating collections 

1. Within the “Collections” screen, click on the box with a green and white 
+ (when you hover your mouse over this, it says “Add Collection”.   

2. Give the collection a name (generally the course name). 

 

 

 

 

3. Repeat the first two steps to create a collection for each of your different 
classes. 

4. To view the contents of a collection, simply click on it. 

5. Options 

a. Pull down the “Options” menu for the collection you wish to edit. 

i. Re-order collections 

ii. Auto-arrange collections 

iii. Rename collections 

iv. Delete collections 

 



12 
 

 

v. Sharing collections – you can click on the “Share” button to 
share a “Collection” with a particular Schoology member 
(such as a colleague in the same discipline). 

b. Whatever change you make, be sure to click the blue “Submit” 
button in order to save the changes. 
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Creating folders (in Collections) 

1. Once you have decided how you will organize your 

course materials, click on the “Add Resources” 

button. 

2. Choose “Add Folder”. 

a. Enter the title of the folder. 

b. Choose a folder color.  (Remember that visual 

cues can help students navigate better.  

Consider color-coding your folders.) 

c. Optional - Enter a description for the folder. 

(I like to put the unit objectives in the folder 

so that they are prominently displayed.) 

 

 

 

d. Add one folder for each unit/module for one of your courses. 
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Changing folder attributes 

1. Click on the “gear” button to the right of the folder you wish to change. 

2. The menu gives you the following choices: 

a. Edit – this will allow you to change the name, color, and 
description of the folder. 

b. Add to course – this copies the folder from your collection to a 
particular course.  DO NOT DO THIS UNTIL YOUR FOLDER IS 
COMPLETE.  Adding a folder to a course does not alter the original 
collection. 

c. Copy to – this copies the current folder from one collection to 
another OR from one folder to another folder within the same 
collection.  The original folder is not altered. 

d. Move to - this moves the current folder from one collection to 
another OR from one folder to another folder within the same 
collection.   The folder will no longer appear in its original location 
as it has been moved. 

e. Delete – use this option carefully, it will delete the folder 
permanently. 
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Uploading files to folders within a Collection 

1. Make sure that before uploading a resource, you are “in the right spot”.  

That is, if you want a resource to be located within a certain collection 

and within a certain folder, make sure you are in that collection/folder 

before adding it, otherwise, you will have to move the resource into the 

folder after the fact.  

2. Click on the “Add Resources” button.  To a folder, you can add a 

subfolder, an assignment, a test or quiz, a file (most common), a link, or 

a discussion.  In this workshop, we will focus on adding folders and files. 

3. Adding pages, external tools, packages, rubrics, media, and badges will 

be discussed in a more advanced Schoology workshop.   

4. Adding assignments, tests/quizzes and question banks are discussed in 

School 4 – Quizzes.  

5. Click on “Add File”. 

6. Choose “File”. 

 

7. Click on “Attach File”. 
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8. Navigate to the file on your desktop computer. 

9. Click “Open”. 

10. When the orange “Uploading” bar changes to a grey “Complete” bar, 

click “Add”. 

11. Repeat steps to add additional files. 
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File formats on Schoology 

1. Schoology supports a great number of different file formats, including: 

a. Word/Pages 

b. Excel/Numbers 

c. PowerPoint/KeyNote 

d. Audio files 

e. Video files (Note: these are large files!  Instead of actually 
uploading a video file to Schoology, consider creating a link to the 
video instead.  This requires only a fraction of the space.) 

f. PDFs  

g. A complete list of supported file types is shown in the table below. 

 

 

  

Supported file types 

Images *.jpg, *.gif, *.png, *.jpeg 

Media (video) 
*.flv, *.mp4, *.mp3, *.mov, *.m4v, *.m4a, *.3gp, *.3g2, *.m2v, 
*.avi, *.mpg, *.asf, *.wma, *.wmv, *.wm, *.swf, *.rm, *.caf 

Files *.doc *.docx, *.pdf, *.ppt, *.xls 
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PDF - Portable Document Format 

1. ADVANTAGE - While you can upload all kinds of documents such as Word 
documents, keep in mind that PDF is the only format that is guaranteed to 
keep your original formatting.  Uploading Word documents to Schoology 
may alter this formatting.) 

2. DISADVANTAGE – Making a file (Word, PowerPoint, etc…) into a PDF 
“flattens” the document, meaning it essentially becomes an uneditable 
image.  The implication is that a Word document that is converted into a 
PDF can no longer be edited in Word.  A PowerPoint that is converted to a 
PDF will show up as  a series of static pages and will lose all animation and 
other effects. 

3. If you upload an assignment as a PDF, students can download it into 
Notability and can annotate it with handwriting or typing and then 
resubmit it to you via Schoology.  (Note the difference between “editing” a 
document, which generally appears seamless, and “annotating” a 
document, in which the annotations are very apparent.) 
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How to create PDFs from Word/Powerpoint 

1. Create the document within Word. 

2. Save the original file as a Word document for your master files.  (This will 
allow you to edit it in the future.) 

3. Pull down the “File” menu and choose “Save As.”  The following dialog box 
will appear. 

 

4. Choose the folder* in which you would like to save the PDF.  Pull down the 
“Save as Type” box and choose “PDF (*.pdf)” from the menu. 

5. In the “File name” box, the original name you gave the file will be displayed.   
You can keep this name or change it at your discretion.  (The original file 
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will remain intact as it ends in “.docx” and therefore is now a different file 
from the PDF you just created.) 

 

*Note:  As you create more and more PDFs from your original files, the number 

of files on your computer will grow.  To keep these files organized, I recommend 

creating a folder within each unit folder on your school computer called 

“Student files” (or whatever name you would like) in which to house these PDFs.  

This also serves the purpose of keeping the files for students separate from your 

original files. 
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Moving a folder from a Collection to a course 

1. The purpose of copying a folder from a Collection to a Course is to give 
your students access to a copy of that folder.  Students will NOT have 
access to the original files in  your collection. 

2. NOTE:  Because it is more efficient to copy an entire folder from a 
collection to a course than to do so with individual files, teachers should 
consider only copying a folder to a course when it is complete or near 
complete. 

3. Click on the “gear” button to the right of the folder you wish to copy to a 
course. 

 

4. Click on “Add to course” – Remember that copying a folder to a course 
does not alter the original collection. 

5. A list of all the courses that you have been assigned will appear.  This 
list is generated from Infinite Campus. 
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6. Check the box  (or boxes) next to the course (or courses) to which you 
wish to add the folder. 

7. When  you click a box next to a course, the computer will ask  you if you 
wish to place the folder within another folder (the default is “None”).  
Since you have already created an organization system under 
Resources/Collections, you will simply copy this into courses. 

8. Click “Add”. 

9. The entire folder contents (including subfolders) will be copied into the 
course (courses). 

 

 

Note:  While it is more efficient to copy an entire folder from a collection to a 

course than to copy individual files, once a folder is added to a course, it and all 

of its contents are available to students.  You can make the folder “hidden” (this 

makes all of its contents hidden as well).  You may wish to consider on what 

timeframe you would like to make files available to students. 
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 Assignments and tests/quizzes within a visible folder can be hidden 

individually even though the folder is visible.   

 This is not the case for files, which retain the same attributes as their 

parent folder.  
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Creating folders & files within a course 

1. While it makes sense to house all of your master files within Resources 

(and this is where you will work during the summer when your classes 

have not yet been created), you can create folders and subfolders 

directly within a course and upload files to those folders.   

a. Creating folders and uploading files directly to a course does NOT 

add them to your Resources.  Therefore, you must back these files 

up to your Resources at the end of the course/year.  

b. If you have multiple sections of the same course and you create 

folders/files within one of those courses, the folders/files are not 

automatically added to the other sections.  They must be copied 

there. 

2. From the main menu, click on “Courses” and then select the course to 

which you would like to add a folder. 

3. Click on the “Add Materials” button to pull down the following menu. 

a. Choose “Add Folder”. 
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b. This dialog box looks very similar to the one when we added a 

folder from Resources:  give the folder a name, choose a folder 

color, and give the folder a description (optional).   

c. The difference in adding a folder to a course (versus Resources) is 

that within a course, you can select a date (or date range) when 

the folder will be visible to students. 

d. You can also change the “Availability” of the folder: 

i. Visible 

ii. Hidden 

iii. Available after start date 
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iv. Available during date range 

4. To add files to a folder, make sure you are “in” the folder, then click on 

“Add Materials” and choose “File”. 

 

a. Click on “Attach File”.  

 

b. Navigate to the file on your desktop computer. 

c. Click “Open”. 

d. When the orange “Uploading” bar changes to a grey “Complete” 

bar, click “Add”. 

e. Repeat steps to add additional files. 

  



27 
 

Copying folders/files from one course to another 

1. Locate the folder or file within a course that you wish to copy to another 

course. 

2. Click on the “gear button” to the right of the folder/file.  From this menu, 

y ou can: 

a. Edit the folder (rename it, change the color, change the 

description, change the availability) or file (rename it). 

b. Set “Student Completion Rules” – this is an advanced feature that 

requires students to complete requirements in sequential order 

(that is the next assignment/requirement will not be available for 

students to submit until the prior requirement has been fulfilled).  

This option will be discussed in an advanced Schoology 

workshop. 

c. Move the folder / file 

d. Copy the folder/ file to Courses 

e. Save the folder / file to Resources 

f. Delete the folder / file 
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3. Choose “Copy to Course 

a. A list of your courses will displayed. 

b. Click the course (or courses) to which you would like to copy the 

folder/files. 

c. Schoology will prompt you to put the items being moved into a 

folder within the course.  “None” is the default.  You don’t need to 

put anything into a separate folder since you have already created 

a quality organization system. 

d. Click on “Copy Folder” (or “Copy” for a file). 

4. The “Move” function works in much the same way, except a copy is not 

made.  Instead, the original folder/file is moved to a new location. 
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Saving folders/files from a course to Resources 

1. To save an individual file from a course to Resources, navigate to the file 
you wish to save and click on the “gear” button to the right of the file. 

2. Choose “Save to Resources”. 

 

3. Schoology will prompt you to select the Collection into which the file 
should be saved.  If you have folders within that Collection, you will also be 
prompted to select a folder. 

4. Click on “Save Copy”.  
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5. To save a folder from a course to Resources, use the same procedure.  
Navigate to the folder you wish to save and click on the “gear” button to the 
right of the folder. 

 

6. Choose “Save to Resources”. 

7. Schoology will prompt you to select the Collection into which the file 
should be saved.  If you have folders within that Collection, you will also be 
prompted to select a folder. 

8. Click on “Save Copy”.  
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Backing up an entire course to Resources 

1. The most efficient means of saving materials from a course to Resources is 
to save the entire course to Resources at the end of the course. 

2. From within a course, click on the “Options” menu and choose “Save Course 
to Resources”. 

 

3. Schoology will prompt you to select the Collection into which the course 
should be saved. 

 

4. Click on “Submit”. 

5. Note:  If you have more than one section of a course, you will only want to 
backup ONE of those sections to avoid having a large number of copies. 
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Notability 

Creating dividers & subjects  

a) To create a divider ( = a class), click 
on the + (plus) button at the top of 
the homescreen.   

a. Choose “divider” 

b. Type in the divider name. 

c. Click on the “Done” button. 

d. Dividers are automatically 
placed at the bottom of the list 
of dividers. 

b) To create a subject (unit division 
within a class or divider), follow the same procedure as above except 
select “Create Subject”. 

a. Name the subject and click on the “Done” button. 

b. Note that new subjects are automatically placed under the last 
divider. 

 

Moving & organizing dividers, subjects & documents  

 

a) To move or re-order a divider, click on the “Edit” button while in view of 
the divider in question.  Click and hold the three horizontal lines to the 
right of the divider in question and drag it until it is in the desired 
position. 

b) To move a subject under a different divider, click on the “Edit” button.  
Click and hold the three horizontal lines to the right of the subject in 
question and drag it until it is in the desired position. 
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Deleting dividers, subjects & documents  

a) To delete a divider, click on the “Edit” button while in view of the 
divider in question.  This will reveal the gear button for each divider.   

a. Click on the gear icon for the divider you wish to delete. 

b. Click on the red “Delete” button. 

c. Click on the confirmation button labeled “Delete This Divider”. 

d. Click on the “Close” or “Delete” button. 

 

b) To delete a subject, click on the “Edit” button while in view of the 
subject in question.  This will reveal the gear button for each divider.   

a. Click on the gear icon for the subject you wish to delete. 

b. Click on the red “Delete” button. 

c. Click on the confirmation button labeled “Delete This Subject”. 

Renaming dividers, subjects & documents  

a) To edit the name a divider, subject or document, click on the “Edit” 
button while in view of the item in question.  This will reveal the gear 
button.   

a. Click on the gear icon for the item you wish to rename. 

b. Edit the name. 

c. Click on “Done”. 
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Importing documents from other programs  

a) From any other 
application (Edmodo, 
your email), you can 
“open” a file in 
Notability by clicking 
on the icon that looks 
like a box with an 
arrow pointing up 
coming out of it.  This 
will open a menu.   

b) One of the options is “Open in Another App”.  Choose this and then 
select the “Notability” icon.  (Be aware that this icon may be hidden on 
the right.  If you cannot see the Notability icon, swipe your finger to the 
left to reveal it.)  This automatically opens the Notability app and will 
display the following “Import” menu: 

c) Choose between the following options: 

a. Create a new note (this opens the file in a new note). 

i. Select the page range (if you want to import all pages of 
your document, click “OK”; if you only want a few pages, use 
the sliders to select those pages and click “OK”. 

ii. The document is now opened in Notability and can be 
annotated. 
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b. Add to another note (this will add the file to an existing note). 

i. Click on “Add to other note”. 

ii. Select the target note (in which to insert the new file). 

iii. Select the page range (if you want to import all pages of 
your document, click “OK”; if you only want a few pages, use 
the sliders to select those pages and click “OK”. 

iv. The document is now opened in Notability and can be 
annotated. 

 


